
 Win Multiple Configurations

JRE Enterprises presents Win Multiple Configurations for Windows.    Win Multiple 
Configurations (WMC) will allow you to save and use up to one-hundred different desktops.    
This includes having different SYSTEM.INI and WIN.INI configurations.    Create desktops 
specific for your children, husband, wife and/or co-worker(s).    Also, password protect any or all 
saved configuration entries -- a good way to protect against accidental access to certain 
applications and/or critical data.    WMC now supports being installed on a server and accessed 
by client workstations, view Installation and Usage.    WMC now includes the program Win 
Change.

Win Change consists of: three functions: Change Text, Find Text, and Find File Types.    Change 
Text provides an easy method to globally change data in INI, PIF, GRP, and other files across 
multiple drives, including network drives.    Find Text provides an easy method to globally find 
text data within any type of    files.    Find File Types provides an easy method to find files by file 
type(s).    When using the Win Change program, help text is displayed for items, at the bottom of 
the window, when the mouse pointer is placed over the items.

Win Multiple Configurations is coded using Microsoft Visual Basic and Microsoft Professional 
ToolKit for Visual Basic.
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Installation and Usage
To install Win Multiple Configurations, run SETUP.EXE.    WMC now supports being installed 
on a server and accessed by many clients.    For server installations, use the OPTIONAL 
INSTALL method, which places all executables (exe, com, bat, dll, vbx) in the application 
directory.    WMC also supports each client machine or each user having their own WMC data 
directory, where saved configuration are stored.    This can be use in a standalone or client/server 
installation and allows up to 100 saved configurations per WMC data directory.

There are now four different ways to use WMC; Classic, Enhanced-Classic, Client/Server, 
Enhanced Client/Server:

Classic WMC:
Classic WMC is where WMC is installed on each workstation.    The person or group of 

people using the workstation can save up to 100 Windows configurations.    The 100 saved 
configurations are shared amongst the people using the workstation.

WMC is installed using either the STANDARD or OPTIONAL installation method on 
each workstation.    Up to 100 configurations can be saved and restored on each workstation. 
Saved configurations are stored in the WMC installation directory.    All users of the workstation 
share the 100 configurations.    This is the standard way to use WMC and was the only way to 
use WMC prior to Version 7.0.

Enhanced-Classic WMC:
Enhanced-Classic WMC is where WMC is installed on each workstation.    The person or 

group of people using the workstation can save up to 100 Windows configurations per WMC 
Data directory.    Each person can specify their own WMC Data directory and need not share it 
with other people.

WMC is installed using either the STANDARD or OPTIONAL installation method on 
each workstation.    The WMCDATAPATH environment variable must be set before using WMC
to a "WMC Data Directory", which is a directory other than the WMC installation directory.    Up
to 100 configurations can be saved and restored per WMC Data Directory.    If each user of the 
workstation sets the WMCDATAPATH environment variable to a different WMC Data Directory,
then each user can save and restore up to 100 configurations.    In this case, the WMCUSER 
environment variable must also be set before using WMC to a unique value for each user; 
otherwise, WMC will not work properly.    Normally, the WMCDATAPATH and WMCUSER 
variables are set in the AUTOEXEC.BAT file.

Example:
    AUTOEXEC.BAT:

set WMCDATAPATH=c:\wmcdata\joe            ' where c: points to a local drive
set WMCUSER=joe

Client/Server WMC:
Client/server WMC only supports the situation where each person or group use only one 

client workstation (Person A always uses workstation 1, Persons C and D always uses 
workstation 2).    Client/server WMC does not support a person or group using multiple client 
workstations (Person A uses workstation 1 and uses workstation 2).    Enhanced Client/Server 



WMC supports the use of multiple client workstations by an individual in certain situations.
WMC is installed using the OPTIONAL installation method on a server.    Client 

workstations connect to the server to execute WMC.    Run CSSETUP.EXE, found in the WMC 
installation directory on the server, for each client to set up the WMC Program Manager Group 
and icons on the client(s).    The WMCDATAPATH environment variable must be set before 
using WMC to a "WMC Data Directory", which is a directory other than the WMC installation 
directory. The directory can reside on the server or the client workstation.    The WMC DATA 
Directory must be a unique directory for each client workstation if the directory(s) reside on a 
server.    Up to 100 configurations can be saved and restored per WMC Data Directory.    If each 
user of the workstation sets the WMCDATAPATH environment variable to a different WMC 
Data Directory, then each user can save and restore up to 100 configurations.    In this case, the 
WMCUSER environment variable must also be set before using WMC to a unique value for 
each user; otherwise, WMC will not work properly.    Normally, the WMCDATAPATH and 
WMCUSER variables are set in the AUTOEXEC.BAT file.

Example:
    AUTOEXEC.BAT:

set WMCDATAPATH=c:\wmcdata\joe            ' where c: points to a local drive
set WMCUSER=joe

Enhanced-Client/Server WMC:
Enhanced-Client/server WMC supports the same as Client/Server WMC, but under 

certain situations it can also support a person or group using multiple client workstations (Person 
A uses workstation 1 and uses workstation 2).    If a person uses multiple client workstations, 
then Enhanced Client/Server WMC will work if each of the client workstations are the same in 
hardware and software configuration.    WMC saves and restores the Windows SYSTEM.INI file,
which contains hardware and software specifics for a workstation.    If the SYSTEM.INI values 
do not match the workstation hardware and software specifics, then Windows may not start!

WMC is installed using the OPTIONAL installation method on a server.    Client
workstations connect to the server to execute WMC.    Run CSSETUP.EXE, found in the WMC 
installation directory on the server, for each client to set up the WMC Program Manager Group 
and icons on the client(s).    The WMCDATAPATH environment variable must be set before 
using WMC to a "WMC Data Directory", which is a directory other than the WMC installation 
directory. The directory must reside on a server.    The WMC DATA Directory must be a unique 
directory for each client workstation.    Up to 100 configurations can be saved and restored per 
WMC Data Directory.    The WMCUSER environment variable must also be set before using 
WMC to a unique value for each user; otherwise, WMC will not work properly.    If each user of 
the workstation sets the WMCDATAPATH environment variable to a different WMC Data 
Directory, then each user can save and restore up to 100 configurations.    Normally, the 
WMCDATAPATH and WMCUSER variables are set in the AUTOEXEC.BAT file.

Example:
    AUTOEXEC.BAT:

set WMCDATAPATH=g\wmcdata\joe              ' where g: points to a server drive
set WMCUSER=joe



 Becoming a Registered User

We thank you for giving Win Multiple Configurations a test drive.    Registration is easy and it 
ensures that we at JRE Enterprises can continue to develop low cost, quality applications for 
Windows.

View REGISTER.WRI for current pricing information and registration form.

Related topics:
License Agreement
WMCREG Program



License Agreement
Copyright © 1993-1996 JRE Enterprises
All Rights Reserved

Installation of Win Multiple Configurations on your computer system implies agreement with the
terms and conditions below.

Distribution of Win Multiple Configurations, its accompanying programs and documentation is 
considered as is.    JRE Enterprises offers no warranties of any kind, expressed or implied.    This 
includes, but is in no way limited to, warranties of Win Multiple Configurations merchant ability 
or fitness for a particular purpose.    Under no circumstances will JRE Enterprises be liable for 
any damages which result from the use of this program or the inability to use it.    Exclusion from
liability includes, but is not limited to, lost profits, lost savings, or any other incidental or 
consequential damages.

Win Multiple Configurations is distributed as Shareware.    It is not free, freeware, or in the 
public domain.    You may use Win Multiple Configurations for a trial period of thirty days, at no 
cost to you, to determine if it fits your needs. If you decide to use
Win Multiple Configurations past the thirty day trial period, you must register and pay the 
applicable registration fee.    Individual copies of the unregistered version of 
Win Multiple Configurations may be given to friends and associates for the same thirty day free 
trial period.    You may also upload Win Multiple Configurations to the public section of a public 
BBS.

You may not modify or disassemble Win Multiple Configurations, nor distribute any modified or
disassembled versions of Win Multiple Configurations.    
Win Multiple Configurations may not be included with any other product without written 
permission from JRE Enterprises.

STANDALONE REGISTRATION:
Standalone registration of Win Multiple Configurations (the "SOFTWARE") permits 
you to use the "SOFTWARE" on a single computer.    The "SOFTWARE" is in "use" on
a computer when it is loaded into temporary memory (i.e., RAM) or installed into 
permanent memory (e.g., hard disk, CD-ROM, or other storage device) of that 
computer.    However, installation on a network server for the sole purpose of internal 
distribution shall not constitute "use" for which separate license is required, provided 
you have a separate license for each computer to which the "SOFTWARE" is 
distributed.    You may make backup copies of Win Multiple Configurations as 
necessary for archival purposes only.

CLIENT/SERVER REGISTRATION:
Server registration of Win Multiple Configurations (the "SOFTWARE") permits you to 
use the "SOFTWARE" on a single network server.    The "SOFTWARE" is in "use" on 
a server when it is installed into permanent memory (e.g., hard disk, CD-ROM, or 
other storage device) of that computer.    Each server registration includes ONE Client 
registration.



Client registration    of Win Multiple Configurations (the "SOFTWARE") permits you to 
use the "SOFTWARE" on a single computer by accessing the "SOFTWARE" 
executables from a network server.    The "SOFTWARE" is in "use" on the client when 
it is loaded into temporary memory (i.e., RAM).    The "SOFTWARE" executables may 
NOT be installed into permanent memory (e.g., hard disk, CD-ROM, or other storage 
device) unless the computer also has a STANDALONE registration.    The 
"SOFTWARE" data files may be installed into permament memory (e.g., hard disk, 
CD-ROM, or other storage device) without a STANDALONE registration.

However, installation on a network server for the sole purpose of internal distribution 
shall not constitute "use" for which separate license is required, provided you have a 
separate license for each computer to which the "SOFTWARE" is distributed.    You 
may make backup copies of Win Multiple Configurations as necessary for archival 
purposes only.

SITE LICENSE REGISTRATION:
Site license registration of Win Multiple Configurations (the "SOFTWARE") permits 
you to use the "SOFTWARE" in any combination of STANDALONE REGISTRATION 
and CLIENT/SERVER REGISTRATION on all computers owned or operated by the 
registering party which reside within the same city limits.

U.S. Government RESTRICTED RIGHTS: Use, duplication, or disclosure by the Government is
subject to restrictions as set forth in subdivision (b)(3)(ii) of the Rights in Technical Data and 
Computer Software clause at 252.227-7013.



Changing the Active Entry Color

To change the Active Entry color from its default of yellow, do the following:
Edit "JREWMC.INI" in the WMC directory    -- this can be done using Notepad

 Add "Hibcolor=????" somewhere after the [Win_Multi_Config] line
???? stands for one of these values:

Black
Red
Green
Yellow
Blue
Magenta
Cyan
White

Any other value for ???? will cause the default color of yellow to be used.
Save "JREWMC.INI" and run WMCSAVE or 'WMCSTRT to see the new color.



Compress Menu Item

Displays the Compress Options Window, which allows the specification of the PKZIP directory 
and whether to use the compress option for saved configurations.



Miscellaneous

Also available from JRE Enterprises are programs JRE Exit, JRE Home Inventory, My Life and 
Win Change.    JRE Exit is a freeware utility that provides four different ways to exit Windows.   
JRE Home Inventory is the Windows Home Inventory program that keeps track of all your 
household items for insurance purposes.    My Life is the definitive diary, word processor, 
scrapbook, and multi-media scrapbook available for Windows.    Win Change is the only utility 
that allows you to make global changes to text strings in GRP, INI, PIF and other types of files.

Theses programs can be found on CompuServe (WINSHARE forum) and America Online 
(Windows software) with a keyword of JRE.

JRE Enterprises can be contacted on CompuServe via mail to ID 71162,2311 or contacted on 
America Online via mail to ID LeeL641756.



Compress Options Window

The compress options window appears if the "compress" menu option is chosen.    This window 
allows you to specify where PKZIP and PKUNZIP are located and whether to compress saved 
configurations to save space using PKZIP.    The path location of PKZIP must be specified if the 
compress option is checked.    Press the drive button to be given a drive/directory list to specify 
where PKZIP resides.    PKZIP and PKUNZIP are assumed to be in the same directory.    The 
PKZIP program name is assumed to be PKZIP.EXE.    The PKUNZIP program name is assumed 
to be PKUNZIP.EXE.

When PKZIP or PKUNZIP are run, they are run in a DOS window using the _DEFAULT.PIF.    
For best results, edit _DEFAULT.PIF using Microsoft's PIF Editor and set the "Close Window on
Exit" check box to true (checked).



Norton Desktop for Windows

Win Multiple Configurations provides native support for Norton Desktop for Windows Version 
2.2 and Version 3.0.    Norton Desktop for Windows must have 'Save Configuration on Exit' 
turned off for WMC to work correctly.    Also, WMC expects the    key combination of 'ALT + C 
+ S' to perform a NDW save configuration for NDW Version 2 and WMC expects, for NDW 3, 
the Save Configuration sub-menu item to be located under the Options menu item.

For NDW 3 users, if the menus have been modified where the Save Configuration menu item is 
no longer found under the Options menu item, then program SAVENDW.EXE must be changed. 
To change this program, use Norton's ScriptMaker and open SAVENDW.SM located in the 
WMC directory.    Modify SAVENDW.SM so it will choose the correct menu item path to 
perform a Save Configuration.    Compile SAVENDW.SM and save the EXE in the WMC 
directory.    For additional help on Norton's ScriptMaker program, reference the Norton manual 
and the ScriptMaker help file.

Prior users of WMC and NDW may want to change their include file list for NDW 
configurations to use wild card entries that match the following specifications:
Windows directory --    WIN.INI, SYSTEM.INI, CONTROL.INI, NDW.INI, *.CDX, and 
*.QAG.
Norton Desktop for Windows directory --    NDW.BIN, *.DAT, *.INI, *.MNU, *.NDB, and 
*.TBR.



PC Tools for Windows

Win Multiple Configurations provides native support for PC Tools for Windows Version 1.0 and 
Version 2.0.    PC Tools for Windows must have the following entry in their AUTOEXEC.BAT 
file, prior to invoking DMCSTRT and/or Windows:

SET PCTOOLS=xxx
where xxx is the drive and directory of the PC Tools for Windows data directory.
EXAMPLE:

SET PCTOOLS=C:\CPS\DATA
Depending on which PC Tools for Windows programs were installed, this entry may already 
exist in the AUTOEXEC.BAT file.

Due to the way PC Tools for Windows works, WMC uses program DMCSTRT to save PC Tools 
for Windows configurations and uses program DMCSTRT any time a PC Tools for Windows 
configuration is involved in a configuration switch.    DMCSTRT is a DOS-based program and 
will automatically be invoked by WMCSTRT, WMCQSTR, WMCSAVE, and WMCQSAV.    See
the Help entry DMCSTRT for additional information on how to set up and use DMCSTRT.



 WMCSAVE Program

The WMCSAVE program is used to save configuration information.    The current Windows 
configuration should be saved with WMCSAVE before attempting to create and save different 
Window configurations.    WMCSAVE allows up to one-hundred configurations to be saved.    
Any time the windows configuration changes, WMCSAVE/WMCQSAV should be invoked to 
store the changes in the appropriate configuration entry.

WMCSAVE easily saves different configuration entries.    These configurations entries can be 
restored by running programs DMCSTRT, WMCSTRT, or WMCQSTR.    DMCSTRT allows 
changing configurations from DOS; WMCSTRT and WMCQSTR allows changing 
configurations from Windows.    WMCSTRT is normally placed in the Windows startup group, 
unless DMCSTRT is being used.

The WMCSAVE program determines the files to save for a configuration entry by the Global 
Include List and the Include File List for that entry.    When first saving a configuration entry, the 
Include File List is initialized based upon the windows shell program being used.    In addition, 
the user can modify the Global Include List and the Include File List.    The Global Include List 
is used to specify files that are to be included for all configurations, the Include File List is 
specific to a configuration and is used to specify files that are to be included for that 
configuration.

If Program Manager is the shell (shell = progman.exe), then the Include File List is initialized 
with the following files in the Windows directory:    WIN.INI, SYSTEM.INI, CONTROL.INI, 
PROGMAN.INI, and WINFILE.INI.

If Norton Desktop is the shell (shell = ndw.exe), then the Include File List is initialized with the 
following files in the Windows directory:    WIN.INI, SYSTEM.INI, CONTROL.INI, NDW.INI, 
*.CDX, and *.QAG.    And with the following files in the Norton Desktop for Windows 
directory:    NDW.BIN, *.DAT, *.INI, *.MNU, *.NDB, and *.TBR.    See Help entry Norton 
Desktop for Windows for additional information on how to use WMC with Norton Desktop.

If PC Tools for Windows is the shell (shell = wndt.exe), then the Include File List is initialized 
with the following files in the Windows directory:    WIN.INI, SYSTEM.INI, and 
CONTROL.INI.    And with the following files in the PC Tools for Windows data directory:    
*.DAT, *.EMS, *.FSS, *.HEP, *.ICC, *.ICL, *.INI, *.OFC, *.SCT, *.SET, and TEMPLATE.*.    
See Help entry PC Tools for Windows for additional information on how to use WMC with PC 
Tools for Windows.

All other shell programs have the Include FileList initialized to the following files:    WIN.INI, 
SYSTEM.INI, and CONTROL.INI

Note:    Any time PROGMAN.INI is in the Include File list, then all *.GRP files specified in 
PROGMAN.INI will be saved.

Related topics:



WMCSAVE Main Window



 WMCSAVE Main Window

The main window of the WMCSAVE program allows up to one-hundred different configuration 
entries to be saved.    The active configuration selection has its text box background color 
different than the other 100 selections' background color.

WMCSAVE displays ten configurations per page.    Press the 0-to-9 PAGE button to cycle 
through the 100 configurations.

Clicking with the left mouse button on any of the entries (pictures) will bring up the Customize 
Options Window.    This window provides the ability to set various options to use when saving 
and restoring the selected configuration.

Clicking with the right mouse button on any of the entries (pictures) will make that entry 
inactive.    All saved configuration files for the entry will be deleted and all configuration options 
set back to their default values.

The File menu item gives provides the ability to exit WMCSAVE.    The Options menu item 
provides the ability to specify the compress option, invoke the fonts process and specify global 
include list.    The Help menu item provides the ability to display the about window, which gives 
the copyright notice and version/release number for Win Multiple Configurations.

The EXIT key will terminate the WMCSAVE program.

Related topics:
Customize Options Window
Add Password Window
Change or Delete Password Window
Password Check Window
Choose New Graphic/Picture Window
Add/Change Text Window
Update File Include List Window
About Window
About



Registration Window

The registration window is used to enter your name and registration code.    After entering a valid
registration code the annoying "Unregistered Shareware" message will stop.    The registration 
code contains no numbers.

The UPDATE button will validate the registration code and will write a valid registration code 
and your name to the JREWMC.INI file.

The EXIT button will close the registration window and exit the Win Multiple Configuration 
Registration program.

Related topics:
About
Becoming a Registered User
License Agreement



Association of Shareware Professionals
This program is produced by a member of the Association of Shareware Professionals 
(ASP).    ASP wants to make sure that the shareware principle works for you.    If you are
unable to resolve a shareware-related problem with an ASP member by contacting the 
member directly, ASP may be able to help.    The ASP Ombudsman can help you 
resolve a dispute or problem with an ASP member, but does not provide technical 
support for members' products.    Please write to the ASP Ombudsman at 545 Grover 
Road, Muskegon, MI USA 49442-9427, Fax 616-788-2765, or send a CompuServe 
message via CompuServe Mail to ASP Ombudsman 70007,3536.



 Customize Options Window

The customize options window appears after an entry has been selected by clicking with the left 
mouse button on the entry's picture.    Seven primary options can be chosen on this window.    
These options are:    Save the current Windows configuration now, Save windows configuration 
on switch, Reboot DOS on switch, Change the text description for the entry, Use a different 
graphic/picture for the entry, Add/Change/Delete a password for the entry, and/or make Inactive 
entries visible on WMCSTRT window..

Click on an option's check box in the picture for additional information on that option.

Select an option by clicking on the option until a "X" (check) appears in its box.    When all 
options needed have been checked, press the Process key to do the options.    Press the Cancel 
key to exit without doing any options. 

Related topics:
WMCSAVE Main Window
Add Password Window
Change or Delete Password Window
Password Check Window
Choose New Graphic/Picture Window
Add/Change Text Window
Update File Include List Window
About Window
Registration Window



 Add Password Window

The add password window appears if the "add a password" option was checked on the
Customize Options Window.    Type in a password from one-to-twelve characters in length in 
both password text fields.    If the same password is typed in both password fields, then the 
password is added.    REMEMBER the password or else the saved configuration entry will not be
accessible.

Press the Done key to save the password.    Press the Cancel key to exit without saving the 
password.

Related topics:
WMCSAVE Main Window
Customize Options Window
Change or Delete Password Window
Password Check Window
Choose New Graphic/Picture Window
Add/Change Text Window
Update File Include List Window
About Window
Registration Window



 Change or Delete Password Window

The change or delete password window appears if the "change/delete a password" option was 
checked on the Customize Options Window.    To change a password,    type in a new password 
from one-to-twelve characters in length in both password text fields.    If the same password is 
typed in both password fields, then the password is changed.    REMEMBER the password or 
else the saved configuration entry will not be accessible.    To delete a password, do not type in 
any characters, just press the Done key.

Press the Done key to change or delete the password.    Press the Cancel key to exit without 
changing or deleting the password.

Related topics:
WMCSAVE Main Window
Customize Options Window
Add Password Window
Password Check Window
Choose New Graphic/Picture Window
Add/Change Text Window
Update File Include List Window
About Window
Registration Window



 Password Check Window

The password check window appears if the "change/delete a password" option was chosen on the
Customize Options Window.    This window will appear before the change/delete password 
window.    The current password must be entered correctly in order to be able to change or delete 
the current password.

Press the Done key after entering the current password.    A total of three try's are allowed to 
enter the correct current password for the configuration entry.    Press the Cancel key to exit 
without changing or deleting the password.

Related topics:
WMCSAVE Main Window
Customize Options Window
Add Password Window
Change or Delete Password Window
Choose New Graphic/Picture Window
Add/Change Text Window
Update File Include List Window
About Window
Registration Window



 Choose New Graphic/Picture Window

The choose new graphic/picture window appears if the "choose new graphic/picture" option was 
checked on the Customize Options Window.    This window allows the specification of a 
different graphic/picture to be displayed for the configuration entry.    The valid graphic formats 
are: BMP, WMF, ICO, and DIB.    Select a graphic by double clicking on its name in the file list 
box.    The graphic will be displayed on the right side of the window as it would look when 
displayed on the main forms of WMCSAVE and WMCSTRT.    Graphics will automatically be 
sized to fit the box size.

Press the Use Graphic key to use the selected graphic for the entry.    Press the Cancel key to exit
without using a graphic.

Related topics:
WMCSAVE Main Window
Customize Options Window
Add Password Window
Change or Delete Password Window
Password Check Window
Add/Change Text Window
Update File Include List Window
About Window
Registration Window



 Add/Change Text Window

The add/change text window appears if the "add/change text" option was checked on the 
Customize Options Window.    This window allows you to enter a text description for the 
configuration entry.    The text entry can be up to 144 characters in length.

Press the Use Text key to use the entered text for the entry.    Press the Cancel key to exit without 
saving the entered text.

Related topics:
WMCSAVE Main Window
Customize Options Window
Add Password Window
Change or Delete Password Window
Password Check Window
Choose New Graphic/Picture Window
Update File Include List Window
About Window
Registration Window



 Update File Include List Window

The update file include list window appears if the "update file include list" option was checked 
and the "save the current windows configuration now" option was checked on the Customize 
Options Window. OR if    the "global include list" menu option is chosen.    This window allows 
you to select additional files to include in the save/restore process for the selected configuration 
entry.    Double click on files in the File Name list to add them to the Include Files list.    Double 
click on the File Name text box (or click on the <-- button) to add a wild card file specification to
the Include Files List.    Files from various drives and/or directories can be added to the list.    
Other types of files, besides INI files, can be added to the list by changing the *.INI in the File 
Name field.    To remove files from the Include Files List, double click on them.

WMC recognizes two wild cards in the File Name text box, the * (asterisk) and the ? (question 
mark).    The * represents one or more characters that a group of files have in common.    The ? 
represents a single character that a group of files have in common.    Refer to the MS-DOS 
manual or Windows 3.1 manual for more information concerning wild cards.

Press the Update File Include List key to process the new include files list.    Press the Cancel 
key to exit without saving any changes made to the include files list.

Related topics:
WMCSAVE Main Window
Customize Options Window
Add Password Window
Change or Delete Password Window
Password Check Window
Choose New Graphic/Picture Window
Add/Change Text Window
About Window
Registration Window



 About Window

The about window displays the copyright notice, the version.release number, and the registration 
status of Win Multiple Configurations.

Related topics:
WMCSAVE Main Window
Customize Options Window
Add Password Window
Change or Delete Password Window
Password Check Window
Choose New Graphic/Picture Window
Add/Change Text Window
Update File Include List Window
Registration Window



 WMCREG Program

The WMCREG program is used to enter the registration code and the registered person's name.    
After entering a valid registration code, the registered user will no longer receive the 
"Unregistered Shareware" messages.

The UPDATE button will validate the registration code and will write a valid registration code 
and the registered name to the JREWMC.INI file in the WMC executables directory.

The EXIT button will exit the WMCREG program.

Related topics:
License Agreement



Save the Current Windows Configuration Now

Checking the "Save the current windows configuration now" option will have the current 
configuration saved.    What files are saved is determined by the Include File List and the Global 
Include List.    If PROGMAN.INI is in the Include File List, then all groups listed in 
PROGMAN.INI will be saved.    If Norton Desktop is the shell, then all QAG files in the 
windows directory and in the Norton Desktop directory will be saved.    This option has four sub-
options:

Issue a Save Setting
Update file include list
Only save group information
WMCSTRT handles StartUp Group



Issue a Save Settings

Checking the "Issue a Save Settings" sub-option allows the user to specify whether WMCSAVE 
will have Program Manager, Norton Desktop, or PC Tools do a "Save Settings", before the 
Windows configuration is saved.    All configuration changes still in memory will be written to 
the hard drive, before WMCSAVE saves the current Window's configuration.



Update File Include List

Checking the "Update file include list" sub-option allows the user to modify the Include File 
List.    The Include File List determines which files are copied when the configuration is 
saved/restored.    This sub-option and sub-option Only save group information are mutually 
exclusive.    The Update File Include List Window will be displayed for specification of the 
Include File List. 



Only Save Group Information

Checking the "Only save group information" sub-option allows the user to specify whether this 
configuration entry will only save group files (*.GRP and PROGMAN.INI).    If only group files 
are saved, then a restart of Windows is NOT needed when switching to this configuration.    
Switch between different group layouts easily, quickly and without restarting Windows!    This 
sub-option is only available if the Windows shell program is Program Manager.    This sub-option
and sub-option Update file include list are mutually exclusive.

Note:
For users of WMC V2.1c or earlier, the following MUST be done before using this sub-option:

Restore each of your saved configurations that uses Program Manager as its shell, this is 
accomplished by using WMCSTRT.    Re-save the restored Windows configurations using
WMCSAVE/WMCQSAV (V3.0 or later).    After all the saved configurations have been 
re-saved,    this sub-option can be used.    If this process is not done, unpredictable result 
will occur when switching to a configuration saved using this sub-option.



WMCSTRT Handles StartUp Group

Checking the "WMCSTRT handles StartUp Group" sub-option allows the user to specify that 
only WMCSTRT will be started when Windows starts.    Once a configuration entry is chosen 
from WMCSTRT/WMCQSTR, then that entry's StartUp group programs are started after any 
necessary saving/restoring of files and restarting of Windows.    This sub-option is only available 
if the Windows shell program is Program Manager.    WMC does not handle programs being 
loaded or run from the WIN.INI RUN= or LOAD=    lines.

WMCSTRT:    Holding the SHIFT key down when selecting a configuration saved with this sub-
option will bypass the running of the programs in the StartUp group.

WMCQSTR:    The program will issue a prompt to determine if programs in the StartUp group 
should be run.



Save Windows Configuration on Switch

Checking the "Save windows configuration on switch" option will save the current configuration
per the include file lists every time a user switches from using this configuration entry to using a 
different configuration entry with program DMCSTRT/WMCSTRT/WMCQSTR.    This 
configuration entry will be kept up-to-date automatically.    If the configuration changes while 
using this configuration entry, those changes will be saved automatically to the configuration 
entry when switching to another configuration entry.    Otherwise, the user will need to manually 
save the configuration, using WMCSAVE/WMCQSAV, anytime a configuration change occurs.

Checking the "Prompt for Save on Switch" option will cause a message box to be displayed 
prompting whether to save the current configuration every time a user switches from using this 
configuration entry to using a different configuration entry with program 
DMCSTRT/WMCSTRT/WMCQSTR.



Issue a Save Settings on Switch

Checking the "Issue a Save Settings on Switch" sub-option allows the user to specify whether 
WMCSTRT/WMCQSTR will have Program Manager, Norton Desktop, or PC Tools do a "Save 
Settings" before saving the current configuration on a switch.    This process will write out any 
configuration changes from memory to the hard drive, before WMCSTRT/WMCQSTR saves the
then current windows configuration.    WMCSTRT must have the /n flag set to issue the Save 
Settings command.



Reboot DOS on Switch

Checking the "Reboot DOS after Switch from Configuration" option will cause the PC to be 
rebooted every time a user switches from this configuration entry to a different configuration 
entry with program DMCSTRT/WMCSTRT/WMCQSTR.

Checking the "Reboot DOS after Switch to Configuration" option will cause the PC to be 
rebooted every time a user switches to this configuration entry from a different configuration 
entry with program DMCSTRT/WMCSTRT/WMCQSTR.

Checking the "Prompt for Reboot..." option will cause a message box to be displayed prompting 
whether to perform the Reboot of DOS after the configurations are switched with program 
DMCSTRT/WMCSTRT/WMCQSTR.



Change the Text Description

Checking the "Change the text description" option allows the user to change the text description 
for the configuration entry.



Use a Different Graphic/Picture

Checking the "Use a different graphic/picture" option allows the user to change the picture being 
used for the configuration entry.



Add/Change/Delete a Password

Checking the "Add/Change/Delete a password" option allows the user to add/change/delete a 
password for the configuration entry.



Inactive Entries Visible on WMCSTRT Window

Checking the "Inactive entries visible on WMCSTRT window" option allows the user to specify 
if inactive entries will be displayed on the WMCSTRT window.    Leaving this option unchecked 
will make inactive entries invisible on the WMCSTRT window.



 WMCQSAV Program

The WMCQSAV program is used to quickly save the current Windows configuration to the 
current WMC configuration entry.    WMCQSAV can also be used to issue a Save Settings 
command to Program Manager or PC Tools, or issue a Save Configuration command to Norton 
Desktop for Windows.    WMCQSAV does not allow you to change configuration options, to 
change configuration options use WMCSAVE, instead.

WMCQSAV can be placed in the StartUp group so it can be accessed quickly when a Save 
Settings and/or a save Windows configuration is needed.

WMCQSAV will accept two command line switches: /c and /s.    The "/c" switch causes 
WMCQSAV to perform a "Save Windows Configuration".    The "/s" switch causes WMCQSAV 
to perform a "Save Settings" for Program Manager or PC Tools or a "Save Configuration" for 
NDW.    Both switches may be used.    If any switch is used, then WMCQSAV will not display 
the "Quick Save" Window.



 WMCSTRT Program

The WMCSTRT program is used to restore a saved configuration.    WMCSTRT should be 
placed in the StartUp group, if DMCSTRT is not being used.

If there are active configuration entries when WMCSTRT runs, WMCSTRT will display a 
configuration selection window.    If there are no active configuration entries when WMCSTRT 
runs, WMCSTRT will end without displaying a configuration selection window.

WMCSTRT will accept three command line switches: /d, /n, and /r.    The "/d" switch causes 
WMCSTRT to always display the configuration selection window, unless there are no active 
configuration entries.    Do NOT use "/d" when WMCSTRT is in the StartUp group as 
WMCSTRT will not work properly.    Do use "/d" when WMCSTRT is in any other group, 
otherwise WMCSTRT will display the configuration selection window on every other run of 
WMCSTRT.    The "/n" switch lets the user exit WMCSTRT without selecting a configuration 
entry.    Without the "/n" switch, WMCSTRT takes complete control of Windows and does not 
allow exit until a configuration entry is selected.    The "/r" switch causes WMCSTRT to refresh 
the Windows desktop with the current active configuration.    The refresh may be needed due to 
accidental deletion of a group.    Previously, you would have had to switched to another 
configuration then switched back to refresh the Windows desktop.    The "/d" and "/n" switches 
can be used together.    The "/r" switch should not be used with other two switches.

WMCSAVE is the counter-part to WMCSTRT.    WMCSAVE saves different configurations.

Related topics:
WMCSTRT Main Window



 WMCSTRT Main Window

The main window of the WMCSTRT program allows the selection of    a configuration entry to 
use from up to one-hundred, previously-saved configuration entries.    The active configuration 
selection has its text box background color different than the other 100 selections' background 
color.

WMCSTRT displays ten configurations per page.    Press the 0-to-9 PAGE buttons to display all 
100 configurations.

Clicking with the left mouse button on any of the active entries (pictures) will restore that 
configuration.    If the selected configuration was saved with the "Only save group information" 
sub-option unchecked, then Windows will be restarted.    If the entry selected was the 
configuration entry last used by Windows, then the StartUp group programs are started if the 
configuration was saved with the "WMCSTRT handle StartUp Group" sub-option checked.

If the SHIFT key is held down when selecting a configuration saved with the "WMCSTRT 
handle StartUp Group" sub-option checked, then the StartUp group programs will not be run.

If an entry is password protected, a prompt for the password is done.    If the password entered is 
correct, then the configuration entry is restored.    A total of three try's are allowed to enter the 
correct current password for the configuration entry.

If the "Inactive entries visible on WMCSTRT window" is on, all entries are displayed, even 
inactive ones.    Clicking on inactive entries has no effect.    If the "Inactive entries visible on 
WMCSTRT window" flag is off, only active entries are displayed.



DMCSTRT Program

The DMCSTRT program is used to restore a saved configuration from native DOS, is used as an 
alternative to WMCSTRT, and MUST be used if PC Tools for Windows is the Window's shell.    
If you place DMCSTRT in the AUTOEXEC.BAT file before the start of Windows, then you 
should remove WMCSTRT from the Windows Start-up group.

If there are active configuration entries when DMCSTRT runs, DMCSTRT will display a 
configuration selection window.    If there are no active configuration entries when DMCSTRT 
runs, DMCSTRT will end without displaying a configuration selection window.

DMCSTRT will accept two command line switches: "/aa" and "/r".    Switch "/aa" specifies 
which configuration entry to use, where 'aa' specifies a saved configuration entry.    Saved 
configuration entries are numbered from 0 to 99.    This is useful if you have MS-DOS Version 6 
and use its multiple DOS configurations capability.    The "/r" switch causes DMCSTRT to 
refresh the Windows desktop with the current active configuration.    The refresh may be needed 
due to accidental deletion of a group.    Previously, you would have had to switched to another 
configuration then switched back to refresh the Windows desktop.    The "/aa" and "/r" switches 
should never be specified at the same time.

!!!IMPORTANT!!!!
Before using DMCSTRT, you must issue the following commands from the DOS prompt:

SET WMCPATH=xxx            (where xxx is the drive and directory of WMC.)
SET WMCWINPATH=yyy      (where yyy is the drive and directory of Windows.)

Example:

SET WMCPATH=C:\JREWMC5
SET WMCWINPATH=C:\WINDOWS

You may want to put this command in your AUTOEXEC.BAT file, so it is issued
every time DOS is started.

Related topics:
DMCSTRT Main Window



DMCSTRT Main Window

The main window of the DMCSTRT program allows the selection of a configuration entry to use
from up to one-hundred, previously-saved configuration entries.    The DMCSTRT window will 
display ten configurations per page.    Press the 0-to-9 PAGE buttons to see all one-hundred 
configurations.    The active configuration entry has its text box background color different than 
the other 100 entry's' background color.

Pressing ENTER, on any of the active entries will restore that configuration.    If an entry is 
password protected, a prompt for the password is done.    If the password entered is correct, then 
the configuration entry is restored.    A total of three try's are allowed to enter the correct current 
password for the configuration entry.

If the "Inactive entries visible on WMCSTRT window" is on, all entries are displayed, even 
inactive ones.    Clicking on inactive entries has no effect.    If the "Inactive entries visible on 
WMCSTRT window" flag is off, only active entries are displayed.

Examples:
    To run DMCSTRT, type from the DOS command prompt:

DMCSTRT
    To automatically select configuration 0, type from the DOS command prompt:
 DMCSTRT /0
    To automatically select configuration 76, type from the DOS command prompt:
 DMCSTRT /76
    To automatically refresh the Windows desktop with the current active configuration,
    type from the DOS command prompt:
    DMCSTRT /r



 WMCQSTR Program

The WMCQSTR program is used to switch between two saved configurations, without having to
bring up the WMCSTRT Window.    WMCQSTR requires a command line switch that specifies 
which configuration entries to switch between.    The command line switch should be in the form 
"/aa/bb", where aa specifies one saved configuration entry and bb specifies another saved 
configuration entry.    Saved configuration entries are numbered from    0 to 99.

WMCQSTR will issue a prompt to determine if programs in the StartUP group should be run.

Create as many of these Program Items as needed to flop between configuration entries at the 
double-click of    the left mouse button.

Examples:
    To switch between configurations 0 and 38, make the command line:

WMCQSTR /0/38
    To switch between configurations 11 and 12, make the command line:

WMCQSTR /11/12



 WMCCOPY Program

The WMCCOPY program is used to copy Program Manager groups from one configuration to 
another configuration.    This program provides an easy method to replicate group information 
across multiple saved configurations.    New software products no longer have to be installed into
each saved configuration.    Install new software in one configuration, then copy the software's 
Program Manager group tothe rest of the configurations with WMCCOPY.

WMCCOPY only supports configurations that use Program Manager as the Windows Desktop.

Select the configuration to copy from by using the scroll bar until the correct configuration is 
displayed in the box.    All the Program Manager groups contained by the configuration will be 
displayed.    Select the group(s) to be copied.    Multiple groups can be selected by holding the 
CTRL or the SHIFT key down while clicking on additional groups.

Select the configuration(s) to copy the groups to.    Multiple configurations can be selected by 
holding the CTRL or the SHIFT key down while clicking on additional configurations.

Press the Copy Group button.    If the group already exists in the configuration being copied to, 
then the group will be replaced.    If the group does not exist, it will be added.    WMCCOPY will 
not allow groups to be copied where the 'copy from' configuration and the 'copy to' configuration
are the same configuration.



Fonts Menu Item

The fonts item will display the sub-list:
Button
Fields
Labels

Click on the item for which you want to modify font defaults.    This will display the standard 
Windows Font Selection box.    Your choices will be applied immediately and will be saved 
automatically.    The next time you use Win Multiple Configurations, these new font defaults will 
be used.



Global Include List Menu Item

The "Global Include List" menu item allows the user to modify the Global Include List of files.    
The Global Include List determines which files are copied for all configurations when the 
configurations are saved/restored.    This is in addition to any files specified to be included by the
Include File List for a specific configuration.    The Update File Include List Window will be 
displayed for specification of the Global Include List. 



About Menu Item

Displays the About Window, which gives the copyright notice and the release number for Win 
Multiple Configurations.    This item is found on the main form of program WMCSAVE by 
choosing the HELP menu item.



Fonts Menu Item

The fonts item will display the sub-list:
Button
Fields
Labels

Click on the item for which you want to modify font defaults.    This will display the standard 
Windows Font Selection box.    Your choices will be applied immediately and will be saved 
automatically.    The next time you use Win Multiple Configurations, these new font defaults will 
be used.



Global Include List Menu Item

The "Global Include List" menu item allows the user to modify the Global Include List of files.    
The Global Include List determines which files are copied for all configurations when the 
configurations are saved/restored.    This is in addition to any files specified to be included by the
Include File List for a specific configuration.



About Menu Item

Displays the About Window, which gives the copyright notice, the version.release number, and 
the registration status for Win Multiple Configurations.      This item is found on the main form of
program WMCSAVE by choosing the HELP menu item.



Registration Menu Item

Displays the Registration Window, which is used to enter your name and registration number.      
This item is found on the main form of program WMCSAVE by choosing the FILE menu item.



Save the Current Windows Configuration Now

Checking the "Save the current windows configuration now" option will have the current 
configuration saved.    What files are saved is determined by the Include File List and the Global 
Include List.    If PROGMAN.INI is in the Include File List, then all groups listed in 
PROGMAN.INI will be saved.    If Norton Desktop is the shell, then all QAG files in the 
windows directory and in the Norton Desktop directory will be saved.



Issue a Save Settings

Checking the "Issue a Save Settings" sub-option allows the user to specify whether WMCSAVE 
will have Program Manager, PC Tools or Norton Desktop do a "Save Settings", before the 
Windows configuration is saved.    All configuration changes still in memory will be written to 
the hard drive, before WMCSAVE saves the current Window's configuration.



Update File Include List

Checking the "Update file include list" sub-option allows the user to modify the Include File 
List.    The include file list determines which files are copied when the configuration is 
saved/restored.    This sub-option and sub-option "Only save group information" are mutually 
exclusive.



Only Save Group Information

Checking the "Only save group information" sub-option allows the user to specify whether this 
configuration entry will only save group files (*.GRP and PROGMAN.INI).    If only group files 
are saved, then a restart of Windows is NOT needed when switching to this configuration.    
Switch between different group layouts easily, quickly and without restarting Windows!    This 
sub-option is only available if the Windows shell program is Program Manager.    This sub-option
and sub-option "Update file include list" are mutually exclusive.

Note:
For users of WMC V2.1c or earlier, the following MUST be done before using this sub-option:

Restore each of your saved configurations that uses Program Manager as its shell, this is 
accomplished by using WMCSTRT.    Re-save the restored Windows configurations using
WMCSAVE/WMCQSAV (V3.0 or later).    After all the saved configurations have been 
re-saved,    this sub-option can be used.    If this process is not done, unpredictable result 
will occur when switching to a configuration saved using this sub-option.



WMCSTRT Handles StartUp Group

Checking the "WMCSTRT handles StartUp Group" sub-option allows the user to specify that 
only WMCSTRT will be started when Windows starts.    Once a configuration entry is chosen 
from WMCSTRT/WMCQSTR, then that entry's StartUp group programs are started after any 
necessary saving/restoring of files and restarting of Windows.    This sub-option is only available 
if the Windows shell program is Program Manager.    WMC does not handle programs being 
loaded or run from the WIN.INI RUN= or LOAD=    lines.

WMCSTRT:    Holding the SHIFT key down when selecting a configuration saved with this sub-
option will bypass the running of the programs in the StartUp group.

WMCQSTR:    The program will issue a prompt to determine if programs in the StartUp group 
should be run.



Save Windows Configuration on Switch

Checking the "Save windows configuration on switch" option will save the current configuration
per the include file list every time a user switches from using this configuration entry to using a 
different configuration entry with program DMCSTRT/WMCSTRT/WMCQSTR.    This 
configuration entry will be kept up-to-date automatically.    If the configuration changes while 
using this configuration entry, those changes will be saved automatically to the configuration 
entry when switching to another configuration entry.    Otherwise, the user will need to manually 
save the configuration, using WMCSAVE/WMCQSAV, anytime a configuration change occurs.

Checking the "Prompt for Save on Switch" option will cause a message box to be displayed 
prompting whether to save the current configuration every time a user switches from using this 
configuration entry to using a different configuration entry with program 
DMCSTRT/WMCSTRT/WMCQSTR.



Issue a Save Settings on Switch

Checking the "Issue a Save Settings on Switch" sub-option allows the user to specify whether 
WMCSTRT/WMCQSTR will have Program Manager, PC Tools or Norton Desktop do a "Save 
Settings" before saving the current configuration on a switch.    This process will write out any 
configuration changes from memory to the hard drive, before WMCSTRT/WMCQSTR saves the
then current windows configuration.    WMCSTRT must have the /n flag set to issue the Save 
Settings command.



Reboot DOS on Switch

Checking the "Reboot DOS after Switch from Configuration" option will cause the PC to be 
rebooted every time a user switches from using this configuration entry to using a different 
configuration entry with program DMCSTRT/WMCSTRT/WMCQSTR.

Checking the "Reboot DOS after Switch to Configuration" option will cause the PC to be 
rebooted every time a user switches to this configuration entry after using a different 
configuration entry with program DMCSTRT/WMCSTRT/WMCQSTR.

Checking the "Prompt for Reboot..." option will cause a message box to be displayed prompting 
whether to perform the Reboot of DOS after the configurations are switched with program 
DMCSTRT/WMCSTRT/WMCQSTR.



Change the Text Description

Checking the "Change the text description" option allows the user to change the text description 
for the configuration entry.



Use a Different Graphic/Picture

Checking the "Use a different graphic/picture" option allows the user to change the picture being 
used for the configuration entry.



Add/Change/Delete a Password

Checking the "Add/Change/Delete a password" option allows the user to add/change/delete a 
password for the configuration entry.



Inactive Entries Visible on WMCSTRT Window

Checking the "Inactive entries visible on WMCSTRT window" option allows the user to specify 
if inactive entries will be displayed on the WMCSTRT window.    Leaving this option unchecked 
will make inactive entries invisible on the WMCSTRT window.



Compress Menu Item

The "Compress" menu item allows the user to specify whether to compress configurations and 
where PKZIP/PKUNZIP can be located.    The Compress Options Window will be displayed for 
specification of the compress options.



 WCHG Program

    Win Change consists of: three functions: Change Text, Find Text, and Find File Types.    
Change Text provides an easy method to globally change data in INI, PIF, GRP, and other files 
across multiple drives, including network drives.    Find Text provides an easy method to globally
find text data within any type of    files.    Find File Types provides an easy method to find files by
file type(s).

Pressing the Change Text button will display the Change Text Window consisting of these folder 
items:

The Specify Changes folder item is where text change criteria can be entered.    Multiple 
change criteria can be entered.    Change criteria must be specified before other folder 
items can be used.

The Find Files folder item is where drives, directories, and file types are specified.    
Then, all files matching the change criteria, for the specified drives, directories and file 
types, will be listed.    Files must be found before the Apply Changes folder item can be 
used.

The Apply Changes folder item is where all found files are changed according to the 
change criteria.    Options concerning the creation back out files and whether to modify 
'read only' files are specified here, too.

The Backout Changes folder item is where back out files can be selected and restored, 
thus undoing any changes done by the Apply Changes process.    Back out files can also 
be deleted.

Note:    Certain types of    files contain internal checksums.    If these files are changed, 
they may become invalid.    Norton Desktop for Windows QAG files and Program 
Manager GRP files are two examples.    Win Change handles GRP files and will update 
their internal checksum.    QAG files should NOT be changed using Win Change, nor 
should any other type of filed containing internal checksums be modified by Win Change.
Always create back out files!!!

Pressing the Find Files by Text button will bring up the Find Files by Text Window consisting of 
these folder items:

The Specify Find Text folder item is where the find text criteria is entered.    Multiple find 
criteria can be entered.    Find criteria must be specified before the Find Files folder item 
can be used.

The Find Files folder item is where drives, directories, and file types are specified.    
Then, all files matching the find criteria, for the specified drives, directiories and file 
types, will be listed.

Pressing the Find Files by Type button will display the Find Files by Type Window where drives,



directories, and file types are selected for processing.    All files matching the file types, for the 
specified drives and    directiories, will be listed.

Pressing the Help button will display this help file.

Pressing the Exit button will close the active window.

The File menu item provides the ability to display the Change Text Window, Find Files by Text 
Window, and the Find Files by Type Window.    Clicking on the Exit menu item will terminate 
Win Change.    The Options menu item provides the ability to change the fonts being used, enable
or disable the minimize on use function, and to invoke the registration process.    The Help menu 
item provides the ability to display the about window, which gives the copyright notice and 
version/release number for Win Change.



 Change Text Window

The Change Text Window consists of the following four folders: Specify Changes, Find Files, 
Apply Changes, and Backout Changes.    A folder can be displayed by clicking on the tab for the 
folder.    Change criteria must be specified first, before the Find Files folder is available to be 
selected.    The Find Files process, the specification of drives, directories, file types and finding 
files, must be done before the Apply Changes folder is available to be selected.    Changes must 
have been applied before the Back Out Changes folder is available to be selected.

The Specify Changes folder item is where text change criteria is entered.    Multiple 
change criteria can be entered.    Change criteria must be specified before the Find Files 
folder item can be selected.

The Find Files folder item is where drives, directories, and file types are specified.    
Then, all files matching the change criteria, for the specified drives, directories and file 
types, will be listed.    Files must be found before the Apply Changes folder item can be 
used.

The Apply Changes folder item is where all found files are changed according to the 
change criteria.    Options concerning the creation back out files and whether to modify 
'read only' files are specified here, too.

The Backout Changes folder item is where back out files can be selected and restored, 
thus undoing any changes done by the Apply Changes process.    Back out files can also 
be deleted from this folder.

Note:    Certain types of    files contain internal checksums.    If these files are changed, they may 
become invalid.    Norton Desktop for Windows QAG files and Program Manager GRP files are 
two examples.    Win Change handles GRP files and will update their internal checksum.    QAG 
files should NOT be changed using Win Change, nor should any other type of filed containing 
internal checksums be modified by Win Change.    Always create back out files!!!



Specify Changes Folder

The Specify Changes folder allows multiple change criteria to be entered.    A maximum length of
149 characters is allowed.    'Change From' text must be specified, i.e. have a minimum length of 
one.    'Change To' text can be blank, i.e. have minimum length of zero.

The "Ignore case" checkbox determines whether a case-sensitive search is done.    When 
checked, the default, Win Change does a case-insensitive search when searching for the "Change 
from" string in files.    For example, an upper case "A" equals a lower case "a".    When 
unchecked, Win Change does a case-sensitive search.    For example, an upper case "A" does 
NOT equal a lower case "a".    Click on the "Ignore case" checkbox to toggle between checked 
and unchecked.    Win Change will use the case of the "Change to" string when updating.

To delete change criteria, double click on the criteria in either list box ("Change from" or 
"Change to").



Find Files Folder

The Find Files folder allows drives, directories, and file types to be selected for processing.    
Once selected, a list of all files which contain text strings that match any one of the "Change 
from" text strings will be produced.

Step 1: Select the drives you wish to search.    By default, only local drives are selected.    To 
select/unselect a drive, click on the drive letter.    A drive is selected when it is highlighted.    
Optional:    Specify a directory:\drive to use for the Quick Build process.

Step 2: Press the Build Dir List button to get a list of all directories on the selected drives.    This 
process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the directory list is built.    Optional:    Press the Quick Build button to get a list 
of all sub-directories for the specified drive:\directory.

Step 3: Select the directories you wish to search.    By default, all directories are selected.    To 
select/unselect a directory, click on the directory name.    To select/unselect a directory and all of 
its associated sub-directories, double-click on the directory name.    A directory is selected when 
it is highlighted.

Step 4: Enter the file types you wish to search.    Multiple file types can be entered.    By default, 
the following file types are searched: *.INI, *.GRP, *.PIF.    To delete a file type from the list, 
double click on it.

Step 5: Press the Find Files button to search for all files that contain one or more of the specified 
"Change from" text strings.    A list of all files that have a match will be produced.    This process 
may take some time to do.    Having Minimize on Use will cause Win Change    to minimize while
the found file list is built.

Step 6: Select the found files you wish to change.    By default, all found files are selected.    To 
select/unselect a found file, click on the file name.    A file is selected when it is highlighted.    At 
this point, the Apply Changes folder can be selected to apply the changes per the specified 
change criteria.    To view or edit a file, double-click on the file name.    Files can be copied, 
moved or deleted by pressing on the Drive button or the Toilet button, respectively.

To copy or move files, select the files to be processed, then click on the Drive button.    The Copy
or Move Selected Files Window will appear, select the destination drive and directory for the 
copy/move and then press the Copy Files or Move Files button.    Press the Exit button to exit the 
window.

To delete files, select the files to be processed, then click on the Toilet button.    A prompt will 
appear to verify whether to delete the selected files.    Choose OK to delete the files, Cancel to 
abort the delete process.



Apply Changes Folder

The Apply Changes folder allows the user to select whether to create back out files and whether 
files with the 'read only' attribute on will be modified.    By default, the create back out files 
option is selected, the modify 'read only' files is not selected.

Pressing the Apply Changes button will apply the change criteria to all selected found files.    
This process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the files are changed.    Win Change will issue a prompt to restart Windows.    If 
you manually restart Windows, then turn off "Save Settings on Exit" if it is on, before exiting 
Windows.    Otherwise, any changes to *.GRP files may be overwritten by Windows.

Note:    Certain types of    files contain internal checksums.    If these files are changed, they may 
become invalid.    Norton Desktop for Windows QAG files and Program Manager GRP files are 
two examples.    Win Change handles GRP files and will update their internal checksum.    QAG 
files should NOT be changed using Win Change, nor should any other type of filed containing 
internal checksums be modified by Win Change.    Always create back out files!!!



Backout Changes Folder

The Backout Changes folder allows the user to select which back out files to restore.    If 
problems occur after changes are applied, this process will restore the files back to their original 
state.    By default, all back out files are selected.    To select/unselect a back out file, click on the 
file name.    A file is selected when it is highlighted.

Pressing the Backout Changes button will undo any and all changes made to the selected files.    
This process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the files are being restored.    Win Change will issue a prompt to restart 
Windows.    If you manually restart Windows, then turn off "Save Settings on Exit" if it is on, 
before exiting Windows.    Otherwise, any changes to *.GRP files may be overwritten by 
Windows.

Pressing the Delete All Backout Files button will delete all backout files.    Once done, Win 
Change will no longer be able to backout its changes.    The deleting of the backout files may 
need to be done to free-up disk space.    Backout files are copies of all files changed by Win 
Change, before the changes were made.



 Find Files by Text Window

The Find Files by Text Window consists of the following two folders: Specify Find Text, and 
Find Files.    A folder can be displayed by clicking on the tab for the folder.    Find Text criteria 
must be specified first, before the Find Files folder is available to be selected.

The Specify Find Text folder item is where the find text criteria is entered.    Multiple find
criteria can be entered.    Find criteria must be specified before the Find Files folder item 
can be used.

The Find Files folder item is where drives, directories, and file types are specified.    
Then, all files matching the find criteria, for the specified drives, directiories and file 
types, will be listed.



Specify Find Text Folder

The Specify Find Text folder allows multiple find criteria to be entered.    A maximum length of 
149 characters is allowed.

The "Ignore case" checkbox determines whether a case-sensitive search is done.    When 
checked, the default, Win Change does a case-insensitive search when searching for the "Change 
from" string in files.    For example, an upper case "A" equals a lower case "a".    When 
unchecked, Win Change does a case-sensitive search.    For example, an upper case "A" does 
NOT equal a lower case "a".    Click on the "Ignore case" checkbox to toggle between checked 
and unchecked.

To delete find criteria, double click on the criteria in the list box.



Find Files Folder

The Find Files folder allows drives, directories, and file types to be selected for processing.    
Once selected, a list of all files which contain text strings that match any one of the "Find" text 
strings will be produced.

Step 1: Select the drives you wish to search.    By default, only local drives are selected.    To 
select/unselect a drive, click on the drive letter.    A drive is selected when it is highlighted.    
Optional:    Specify a directory:\drive to use for the Quick Build process.

Step 2: Press the Build Dir List button to get a list of all directories on the selected drives.    This 
process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the directory list is built.    Optional:    Press the Quick Build button to get a list 
of all sub-directories for the specified drive:\directory.

Step 3: Select the directories you wish to search.    By default, all directories are selected.    To 
select/unselect a directory, click on the directory name.    To select/unselect a directory and all of 
its associated sub-directories, double-click on the directory name.    A directory is selected when 
it is highlighted.

Step 4: Enter the file types you wish to search.    Multiple file types can be entered.    By default, 
the following file types are searched: *.INI, *.GRP, *.PIF.    To delete a file type from the list, 
double click on it.

Step 5: Press the Find Files button to search for all files that contain one or more of the specified 
"Find" text strings.    A list of all files that have a match will be produced.    This process may 
take some time to do.    Having Minimize on Use will cause Win Change to minimize while the 
found file list is built.

Step 6: Select the found files you wish to change.    By default, all found files are selected.    To 
select/unselect a found file, click on the file name.    A file is selected when it is highlighted.    To 
view or edit a file, double-click on the file name.    Files can be copied, moved or deleted by 
pressing on the Drive button or the Toilet button, respectively.

To copy or move files, select the files to be processed, then click on the Drive button.    The Copy
or Move Selected Files Window will appear, select the destination drive and directory for the 
copy/move and then press the Copy Files or Move Files button.    Press the Exit button to exit the 
window.

To delete files, select the files to be processed, then click on the Toilet button.    A prompt will 
appear to verify whether to delete the selected files.    Choose OK to delete the files, Cancel to 
abort the delete process.



 Find Files by Type Window

The Find Files by Type window allows drives, directories, and file types to be selected for 
processing.

Step 1: Select the drives you wish to search.    By default, only local drives are selected.    To 
select/unselect a drive, click on the drive letter.    A drive is selected when it is highlighted.    
Optional:    Specify a directory:\drive to use for the Quick Build process.

Step 2: Press the Build Dir List button to get a list of all directories on the selected drives.    This 
process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the directory list is built.    Optional:    Press the Quick Build button to get a list 
of all sub-directories for the specified drive:\directory.

Step 3: Select the directories you wish to search.    By default, all directories are selected.    To 
select/unselect a directory, click on the directory name.    To select/unselect a directory and all of 
its associated sub-directories, double-click on the directory name.    A directory is selected when 
it is highlighted.

Step 4: Enter the file types you wish to search.    Multiple file types can be entered.    By default, 
the following file types are searched: *.INI, *.GRP, *.PIF.    To delete a file type from the list, 
double click on it.

Step 5: Press the Find Files button to create a list of all files.    Having Minimize on Use will 
cause Win Change to minimize while the found file list is built.

Step 6: Select the found files you wish to change.    By default, all found files are selected.    To 
select/unselect a found file, click on the file name.    A file is selected when it is highlighted.    To 
view or edit a file, double-click on the file name.    Files can be copied, moved or deleted by 
pressing on the Drive button or the Toilet button, respectively.

To copy or move files, select the files to be processed, then click on the Drive button.    The Copy
or Move Selected Files Window will appear, select the destination drive and directory for the 
copy/move and then press the Copy Files or Move Files button.    Press the Exit button to exit the 
window.

To delete files, select the files to be processed, then click on the Toilet button.    A prompt will 
appear to verify whether to delete the selected files.    Choose OK to delete the files, Cancel to 
abort the delete process.



 Copy or Move Selected Files Window

The Copy or Move Selected Files window allows the user to specify where the selected files will 
be copied and/or moved.    Select the appropriate drive and directory, then press either the Copy 
Files button or the Move Files button.

Pressing the Exit button will close the window.



Fonts Menu Item

The fonts item will display the sub-list:
Button
Fields
Labels

Click on the item for which you want to modify font defaults.    This will display the standard 
Windows Font Selection box.    Your choices will be applied immediately and will be saved 
automatically.    The next time you use Win Change, these new font defaults will be used.



Minimize on Use Menu Item

This menu item displays a check when "Minimize on Use" is enabled.    Clicking on the menu 
item will toggle between checked and unchecked.    When the menu item displays "Minimize on 
Use", Win Change will be minimized whenever a lengthy process occurs, such as building the 
directory list, finding files, or changing files.








